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Virtual Deployment Overview

This document provides instructions on the installation and configuration of NetWitness 11.5.0.0 hosts
running in a virtual environment.

Virtual hosts have the same functionality as the NetWitness Azure, AWS, and hardware hosts. RSA
recommends that you perform the following tasks when you set up your virtual environment.

Before you can deploy NetWitness in virtual environment, you need to:

IMPORTANT: Get familiar with the NetWitness Storage Guide to understand the types of drives and
volumes needed to support NetWitness instances. For more information, see Storage Guide for RSA
NetWitness® Platform 11.x.

o Review the recommended compute and memory specifications needed for each NetWitness instance.

e Make sure that you have a NetWitness Throughput license.

* Review of the network architecture and port usage.

Process

The components and topology of a NetWitness network can vary greatly between installations, and
should be carefully planned before the process begins. Initial planning includes:

» Consideration of site requirements and safety requirements.

» Support of group aggregation on Archivers and Concentrators, and virtual hosts.

When updating hosts and services, follow recommended guidelines under the "Running in Mixed Mode"
topic in the RSA NetWitness Host and Services Getting Started Guide.

You should also become familiar with Hosts, Host Types, and Services as they are used in the context of
NetWitness also described in the RS4 NetWitness Host and Services Getting Started Guide.
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NetWitness High-Level Deployment Diagram

NetWitness is inherently modular. Whether organizations are looking to deploy on-premise or in the
cloud, the NetWitness components are decoupled in a way which allows flexible deployment
architectures to satisfy a variety of use cases.

The following figure is an example of a hybrid cloud deployment, where the base of the components are
residing within the SecOps VPC. Centralizing these components make management easier while keeping
network latency to a minimum.

Network, log and endpoint traffic could then be aggregated up to the SecOps VPC. The on-premise
location would function just like a normal physical deployment and would be accessible for
investigations and analytics.

Cloud SaaS visibility could be captured from a Log Decoder residing in either the cloud or on-premise
locations.
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For information on VMware concepts, refer to the VMware product documentation.

The virtual hosts are provided as an OVA. You need to deploy the OVA file as a virtual machine in your
virtual infrastructure.

Installation Media

Installation media are in the form of OVA and VHDX packages, which are available for download and
installation from Download Central (https://download.rsasecurity.com). As part of your order fulfillment,
RSA gives you access to the OVA and VHDX.

Virtual Deployment Overview 6
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Install NetWitness Platform Virtual Host in Virtual

Environment

Complete the following procedures according to their numbered sequence to install NetWitness in a
virtual environment.

Work Flow:

This figure shows the high-level workflow mandatory for installing NetWitness Platform virtual host.

Create Virtual

Machine - VMware T

Configure Block

Create Virtual Storage to Install RSA Configure Host-
Machine — Nutanix 222 =™ Accommodate NetWitness Specific
AHV NetWitness Platform Parameters

Platform

Create Virtual

Machine — Microsoft
Hyper-V

Note: When you configure databases to accommodate NetWitness Platform, the default database space
allocation after you deploy databases from OVA or VHDX will not be adequate to support the
NetWitness deployment. You must expand the datastores after initial deployment to avoid any issues.
For more information, see Step 2. Configure Block Storage to Accommodate NetWitness Platform.

IMPORTANT: Review the Network Architecture and Ports topic in the Deployment Guide in the
NetWitness help so that you can configure NetWitness services and your firewalls. Go to the
NetWitness Documents - All Versions to find all RSA NetWitness Platform 11.x documents.

Caution: Do not proceed with the installation until the ports on your firewall are configured.

Prerequisites

Make sure that you have:

7 Install NetWitness Platform Virtual Host in Virtual Environment
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e A VMware ESX Server that meets the requirements described in the above section. Supported
versions are 7.0, 6.7, 6.5, 6.0, and 5.5.

* Administrator rights to create the virtual machines on the VMware ESX Server.

Checklist

N

1. Step 1a. Create Virtual Machine - VMware

2. Step 1b. Create Virtual Machine - Microsoft Hyper-V

4. Step 1c. Create Virtual Machine - Nutanix AHV

3. Step 2. Configure Block Storage to Accommodate NetWitness Platform
5. Step 3. Install RSA NetWitness Platform

Step 4. Configure Host-Specific Parameters

&

Step 5. Post Installation Tasks

Step 1a. Create Virtual Machine - VMware

Complete the following steps to deploy the OV A file on the vCenter Server or ESX Server using
the vSphere client.

Prerequisites

Make sure that you have:

» Network IP addresses, netmask, and gateway IP addresses for the virtual host.
* Network names for all virtual hosts, if you are creating a cluster.

* DNS or host information.

e Password for virtual host access. The default username is root and the default password
is netwitness.

* The NetWitness virtual host package file for example, rsanw-11.5.0.0.xxxx.el7-x86_64.ova. (You
download this package from Download Central (https://community.rsa.com).)

Procedure

Note: The following instructions illustrate an example of deploying an OV A host in the ESXi
environment. The screens you see may be different from this example.

To deploy the OVA host:

Install NetWitness Platform Virtual Host in Virtual Environment 8
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. Log on to the ESXi environment.

In the File drop-down, select Deploy OVF Template.

FiIelEdit View Inventory Administration Plug-ins Help

M ew

k

Deploy OVF Template...

Export
Report

Browse VA Marketplace...

Print Maps
Exit

The Deploy OVF Template dialog is displayed. In the Deploy OVF Template dialog, select

the OVF for the host that you want to deploy in the virtual environment (for example, V11.5

Install NetWitness Platform Virtual Host in Virtual Environment
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GOLD\Wrsanw-11.5.0.0.xxxx.el7-x86_64.0va), and click Next.

(% Deploy OVF Template

Source
Select the source location.

Source

OVF Template Details
Mame and Location
Storage

Disk Format

Ready to Complete

Deploy from a file or URL

P omoted 00jovafrsanw-11.2.0.0.3200.el7-x86_64.ove R Browse...

Enter a URL to download and install the OVF package from the Internet, or
specify a location accessible from your computer, such as a local hard drive, a
network share, or a CO/OVD drive,

Help |

< Back | Mext = I Cancel

4. The Name and Location dialog is displayed. The designated name does not reflect the server
hostname. The name displayed is useful for inventory reference from within ESXi.

5. Make a note of the name, and click Next.

Storage Options are displayed.

Install NetWitness Platform Virtual Host in Virtual Environment 10
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Storage
Where do you want to store the virtual machine files?

Source Select a destnation storage for the virtual machine files:
/F Template Details -

End Liser Licanse Agrasmant Name | Drive Type | Capadity | Provisioned | Free | Type | “Thin Fr

——T—— darasterel Nen-SaD 14400 GE 374 GE 14028 GB WMFSS  Suppm

Storage datastore2 Non-S5D 181878 15.67 T8 78478 VMFS5S  Suppor

Disk Format

Metwork Mapping

Fueady to Complete

6. For Storage options, designate the datastore location for the virtual host and click Next.

(@ Deploy OVF Template — O ad

Disk Format
In which format do you want to store the virtual disks?

Source Datastore: Idaiastorel
OVF Template Details
lame and Location Available space (GB): 55.0

Disk Format
Network Mapping
Ready to Complete

™ Thick Provision Lazy Zeroed

¢ Thick Provision Eager Zeroed ‘___

" Thin Provision

< Back | Next = I Cancel U

Note: This location is for the host operating system (OS) exclusively. It does not have to be the
same datastore needed to set up and configure additional volumes for the NetWitness databases on
certain hosts (covered in the following sections).

7. Click Next.

11
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The Network Mapping options are displayed.

Hetwork Mapping
What networks should the deployed template use?

Soyros
OVE Template Detals Map the networks used n ths OVF template o networks in your ventory

End User License Agresment

Mame and Location Source Metworks Destination Networks
Sfgrage Netwodk 1 [ P bk, »
Disk Format

Network Mapping Locakzabon-WMhetwork
Ready to Complate VM Metwork Traffic Gen

The Network 1 netvork -

8. Select the Network label based on your requirement (For example, VM Network), and click Next.

Note: If you want to configure Network Mapping now, you can select options, but RSA
recommends that you keep the default values and configure network mapping after you configure
the OVA. You configure the OVA in Step 4: Configure Host-Specific Parameters.

A status window showing deployment status is displayed.
(&) 7% Deploying rsanw- f5 h i, — x
Deploying rsanw- fob sk et olm T

Deploying disk 1 of 1
¥ Close this dialog when completed

After the process is complete, the new OVA is presented in the designated resource pool visible
on ESXi from within vSphere. At this point, the core virtual host is installed, but is still not
configured.

Step 1b. Create Virtual Machine - Microsoft Hyper-V

Complete the following steps according to their numbered sequence to deploy virtual host in Hyper-V.

Prerequisites

Make sure that you have:

Install NetWitness Platform Virtual Host in Virtual Environment 12
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e Network IP addresses, netmask, and gateway IP addresses for the virtual host.
e Network names for all virtual hosts, if you are creating a cluster.
e DNS or host information.

e Password for virtual host access. The default username is root and the default password
isnetwitness.

* The NetWitness virtual host package file for example, rsa-nw-11.5.0.0.3274.zip. (You
download this package from Download Central https://community.rsa.com)

Procedure

Note: The following instructions illustrate an example of deploying a VM in the Hyper-V
environment. The screens you see may be different from this example.

To deploy virtual host in Hyper-V.
1. Log on to Hyper-V Manager.

2. Click Import Virtual Machine and Click Next.

[#1Import Virtual Machine X
Actions
=] Before You Begin WIN-AUBUICUSIRN
New
& Import Virtual Machine...
Before You Begin This wizard helps you import a virtual machine from a set of configuration files. It guides you through .
Locate Folder resolving configuration problems to prepare the virtual machine for use on this computer. -] Hyper-V Settings...

73 Virtual Switch Manager...
Select Virtual Machine e 9

Choose Import Type oo Virtual SAN Manager...

Edit Disk...

Summary

Inspect Disk...

Stop Service

Remove Server

c X

Refresh
View

ﬂ Help

[] Do not show this page again

13 Install NetWitness Platform Virtual Host in Virtual Environment


https://community.rsa.com/

Virtual Host Installation Guide

3. In the Import Virtual Machine dialog, specify the path where the zip file is extracted and Click
Next.

Import Virtual Machine

[#] Locate Folder

Before You Begin Specify the folder containing the virtual machine to import.
Locate Folder Folder: I :\Users\Administrator \Desktop Browse...

Select Virtual Machine
Choose Import Type

Summary

< Previous Cancel

Install NetWitness Platform Virtual Host in Virtual Environment
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4. Select the Virtual Machine and Click Next.

Import Virtual Machine X

Select Virtual Machine

Before You Begin Select the virtual machine to import:
Locate Folder -~
Name Date Created
Select Virtual Machine
[— 1/8/2019 11:43:47PM
Choose Import Type
Summary

< Previous Next > Fin Cancel

15 Install NetWitness Platform Virtual Host in Virtual Environment
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5. Choose copy the Virtual machine (create a new unique ID) Import Type.

[#] Import Virtual Machine X
(] Choose Import Type
Before You Begin Choose the type of import to perform:
Locate Folder (O Register the virtual machine in-place (use the existing unique ID)
Select Virtual Machine (O) Restore the virtual machine (use the existing unique ID)
(® Copy the virtual machine (create a new unique ID)
Summary
< Previous Cancel
Install NetWitness Platform Virtual Host in Virtual Environment 16
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6. In the Choose Destination section, specify the new or existing folder to store the Virtual Machine

files.

[#] Import Virtual Machine

Before You Begin
Locate Folder

Select Virtual Machine
Choose Import Type
Choose Storage Folders

Summary

X

Choose Folders for Virtual Machine Files

You can specify new or existing folders to store the virtual machine files. Otherwise, the wizard
imports the files to default Hyper-V folders on this computer, or to folders spedified in the virtual
machine configuration.

[[] store the virtual machine in a different location
C:\ProgramDataWMicrosoft\Windows\Hyper-V\
C:\ProgramData Microsoft\Windows\Hyper-V\

C:\ProgramDataWMicrosoft\Windows\Hyper-V\

< Previous Cancel

17
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7. In the Choose Storage Folder section, specify the location where you want to store multiple Virtual

Machine deployments.

Import Virtual Machine XK
Choose Folders to Store Virtual Hard Disks
Before You Begin Where do you want to store the imported virtual hard disks for this virtual machine?
Locate Folder Location: [ :\Users\Public\Documents\Hyper-V\Virtual Hard Disks\} Browse...
Select Virtual Machine
Choose Import Type
Choose Destination
Choose Storage Folders
Summary
< Previous Cancel
Install NetWitness Platform Virtual Host in Virtual Environment 18




Virtual Host Installation Guide

8. In the Connect Network section, specify the Network name for the Virtual Machine to connect.

[#] Import Virtual Machine

Connect Network

Before You Begin This page allows you to connect to virtual switches that are available on the destination computer.

Locate Folder
The following configuration errors were found for virtual machine ‘rsa-nw

Select Virtual Machine
0 Could not find Ethernet switch ‘testinternal’.

Choose Import Type
Choose Destination Spedify the virtual switch you want to use on computer "WIN-AUBUICUSIRN",
Choose Storage Folders

Connect Network

Summary

Connection: | Intel(R) Gigabit 4P X540,1350 rNDC #2 - Virtual Switch ~

< Previous Cancel
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9. Check the Summary, if all the details are correct, click Finish.

Import Virtual Machine X

[#] Completing Import Wizard

Before You Begin You are about to perform the following operation.

Locate Folder Description:

Select Virtual Machine Virtual Machine: -

Choose Import Type Import file: C:\Users\Administrator\Desktop\11. 2\Virtual Machines\DB6ASSt

Choose Destination Import Type: Copy (generate new ID)

Choose Storage Folders Virtual mfachine configuration folder: C:\FrogramData\M:lcrosoft\&"a’:lndows\Hyperf\f\
Checkpoint folder: C:\ProgramData \Microsoft\Windows'\Hyper-v\

Connect Network Smart Paging file store: C:\ProgramData \Microsoft\Windows\Hyper-V\

Virtual hard disk destination folder:  C:\Users\Public\Documents\Hyper-V\Virtual Hard Disks\

Network connection: Intel(R) Gigabit 4P X540/I1350 rNDC £2 - Virtual Switch
< >

To complete the import and dose this wizard, dick Finish.

< Previous Cancel

Step 1c. Create Virtual Machine - Nutanix AHV

Nutanix AHV is an enterprise-ready hypervisor, offering integrated virtualization, app mobility,
management, operational insights, and security. Complete the following steps according to their
numbered sequence to deploy virtual host in Nutanix Acropolis Hypervisor (AHV).

Prerequisites

Make sure that you have:

Network IP addresses, netmask, and gateway IP addresses for the virtual host.
Network names for all virtual hosts, if you are creating a cluster.
DNS or host information.

Password for virtual host access. The default username is root and the default password
is netwitness.

Install NetWitness Platform Virtual Host in Virtual Environment 20
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e The NetWitness 11.5 or later ISO file which is available for download from Download Central
(https://download.rsasecurity.com).

e Administrative user account on Nutanix Prism.

Procedure

Note: The following instructions illustrate an example of deploying a VM in the Nutanix AHV
environment. The screens you see may be different from this example.

Create Image on Nutanix AHV

1. Log in to the Nutanix Prism GUI.

21 Install NetWitness Platform Virtual Host in Virtual Environment
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2. From the drop-down menu, click Settings and select Image Configuration.

Nutanix_Perf

Hypervisor Su... Prism Central Cluster-wide Controller IOPS 15 10PS Health Critical Alerts
Not registered to 16 I0PS
AH\/ Prism Central SR
VERSION NUTANIX Register or create ‘ 14
20170830.270 1:00 0 o CRITICA!
Storage Summary Logical v Cluster-wide Controller |0 B/W1.22 MBps o1 0 &0 Node Detached From Metadata Ring
8 days ag
3.64TiB free (logical) of 3.79 TiB Hosts @0 2 o0 Two node cluster changed state to stand-
U alone mode
0 0o es !
VM Summary Cluster-wide Controller Latency =~ 4.7 ms Data Resiliency Status Warning Alerts
Avai... Best Effort 5940 Yetected older A
6 e On 6 '
Off 0 tected older AHV
VM(S) Suspen 0 prees SARNING =
e Pau 0 s 2 months ago P =
- UN
Dat
Hardware Summary Cluster CPU ... Cluster Memo... o ! f . Info Alerts Events

MODE

2 2 wamses 998,  85.99 14 259

Nutanix_Perf

Image Configuration

Settings

+ Upload Image
Cluster Details

Configure CVM

Image Configuration PR 4
Licensing

7 X
Reboot

Remote Support

%
Upgrade Software

/7 X

£ R
Connect to Citrix Cloud 7 X

Prism Central Registration
Pulse

Rack Configuration

3. Click Upload Image.

4. In the Create Image dialog, select Image Type as ISO. Specify other details based on your
requirements.

5. Select Upload a file and click Choose File.

6. Browse to the stored location of the NetWitness 11.5 or later ISO file and select it.

Install NetWitness Platform Virtual Host in Virtual Environment 22



Virtual Host Installation Guide

7. Click Save.

Create VM on Nutanix AHV

1. In the Nutanix Primis GUI, click VM, from the drop-down menu.

Hypervisor Summary Cluster-wide Controller IOPS 3010PS Health
<
Storage Summary ogical ~ Cluster-wide Controller 10 B/W. 215 KBps . -
9TiB free (logical) of 9. E .0 1 eo
. .6
VM Summary Cluster-wide Controller Latency 1.96 ms Data Resiliency Status

5

coNnuw 3

Hardware Summary Cluster CPU Usage Cluster Memory Usage

MODE!

11 NX-3060-G5 2239 1577 . ne

Critical Alerts

Warning Alerts

Info Alerts

Events

2. Go to the Table view and click Create VM.

n ) Include Controller VMs

10381, 4 8Gi8 49.08 MiB/ 1GiB 0.24 3.44 [ -]
5.46 GiB / 641.44
10381, a 16 Gig .83 51.43% 0 22
GiB
Windows 10 VM a 8GiB 10.47 GiB / 40 GiB [ 0%
Windows 2012 VM a 8GiB 964 GiB / 40 GiB [ [\

Summary

VM SUMMARY Performance Summary

2KBps

160 KBps.

All VM Tasks

066 ms

187 ms

Yes

No

No

No

3. In the Create VM dialog, enter the required details such as name, description, time zone, vCPU,

cores per vCPU, etc. For more information, see Creating a VM (AHV) in the Prism Web Console

Guide.
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4. In the Create VM dialog, scroll down to the Disks section and click Add New Disk.

Update VM

Boot Configuration

Legoacy 8105

? x

Install NetWitness Platform Virtual Host in Virtual Environment
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A -

Add Disk ’ x

5. In the Add Disk dialog, do the following:
a. Select DISK in the Type field and specify other details based on your requirement.
b. Select Allocate on Storage Container in the Operations field.
c. Select SCSI as Bus Type.

1. In the Add Disk dialog, select CD-ROM as the Type.

2. Select Clone from Image Service in the Operations field and IDE as Bus Type.

25 Install NetWitness Platform Virtual Host in Virtual Environment
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3. Select the NetWitness 11.5 or later ISO file that you uploaded in Step 6 in the Image field.

ccccc

4. Select Clone from Image Service in the Operations field and IDE as Bus Type.

5. Click Add and enter other details such as adding network adapters, GPU, etc.
6. Click Save. You can now see your VM in the VM list.

IMPORTANT: Ensure that you eject the CD-ROM after installing the NetWitness Platform.
Otherwise, every time you reboot the VM it will boot from CD-ROM.

Step 2. Configure Block Storage to Accommodate

NetWitness Platform

When you deploy databases from OVA or VHDX, the initial database space allocation is not adequate
for production environment. You need to add or expand the datastores volume after installation.

Task 1. Add New Disk

Get familiar with the RSA NetWitness® Platform Storage Guide to understand the types of drives and
volumes needed to support NetWitness instances. For more information, see Storage Guide for RSA
NetWitness® Platform 11.x

Add New Disk

Add New Disk in VMware ESXi
Add New Disk in Hyper-V
Add New Disk in Nutanix AHV

Install NetWitness Platform Virtual Host in Virtual Environment 26
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Add New Disk in VMware ESXi

This procedure shows you how to add a new 100 GB disk on the same datastore.

Note: The procedure to add a disk on different datastore is similar to the procedure shown here.

1. Shut down the machine, edit Virtual Machine Properties, click Hardware tab, and click Add.

(%) rsa_concentrator - Virtual Machine Properties — (] X
Virtual Machine Version: 7
Memory Configuration
I~ Show All Devices Add...
255GBd  Memory Size: 164 [e~
Hardware | Summary g lM
B Maximum recommended for this
& Memory Ll 4 guestOS: 255 GB.
A crus 4 64 GB
vid d vid d Maximum recommended for best
& videocan 1deo car 3268l A performance: 147444 MB.
& VMCldevice Deprecated e — .
@ scsIcontroller 0 Paravirtual 16 GBH 4 guestOs: 2GB.
@ scstcontroller 1 Paravirtual R e R Tee It
@ scstcontroller2 Paravirtual sy < guestOS: 512 MB.
@ scstcontroller3 Paravirtual 468 H
@ co/ovD drive 1 CD/DVD drive 0
o Hard disk1 Virtual Disk 2GB e
& Hard disk2 Virtual Disk 168
& Hard disk3 Virtual Disk
& Hard disk4 Virtual Disk S1z2MBEd
B Network adapter1 Private 256 vl
128 MBH
64 B H
B
16 MBH
8MBH
< > 4meU

oK Cancel

2. Select Hard Disk as the device type.

(%) Add Hardware - I

Device Type
What sort of device do you wish to add to your virtual machine?

Choose the type of device you wish to add.

Informati
This devic

CD/OVD Drive (unavailable)

USB Controller

R, SCSI Device

3. Select Create a new virtual disk.
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Select a Disk
M‘i@_ A virtual disk is composed of one or m
Select a Disk files appear as a single hard disk to t
Create a Disk
Advanced Options Select the type of disk to use.
Ready to Complete Disk

I(: Create a new virtual disk I

4. Choose the size of the new disk and where you want to create it (on the same datastore or a different
datastore).

Note: Choose data provisioning based on your requirements

@ .
Create a Disk
Spedfy the virtual disk size and provisioning policy

Revice Type Capadty

Select & Dk i

Create a Disk Disk Size: I 1005- GB '|
Advanced Opbons

Ready to Complete Disk Provisioning

" Thick Provision Lazy Zeroed
% Thick Provision Eager Zeroed
" Thin Provision

Locaton

% Store with the virtual machine
" Specfy a datastore or datastore custer:

| _Brome... |

5. Approve the proposed Virtual Device Node.
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Device Type Spedfy the advanced options for this virtual disk. These options do not normally need
Select a Disk to be changed.

Create 3 Desk

Advanced Options Virtual Device Node

Ready to Complats ISCSI {0:4) _'J

Mode
™ Independent

Independent disks are not affected by snapshots.
P

Changes are immediately and permanently written to the disk.

-
Changes to this disk are discarded when you power off or revert to the
snapshot.

Note: The Virtual Device Node can vary, but it is pertinent to /dev/sdX mappings.

6. Confirm the settings.

Device Type Options:
select a Disk
Create a Disk Hardware type: Hard Disk
Advanced Options E‘;{at‘ disk: N;a”s“;t”” disk
Ready capacity: 1
to Gonptute Datastore: date:storage
Virtual Device Node: SCSI (0:4)
Disk mode: Persistent
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Add New Disk in Hyper-V
1. Shut down the VM and click Settings and IDE Controller, sclect the Hard Drive and click Add.

rsa-nw-11.2.0.0.3274

=

Created:  1/16/2019 12:27:52 AM
version: 5.0
Generation: 1

‘Actions
Virtual Machines N
Name — * State CPUUsage  Assigned Memory  Uptime Status New N
5 manw112003274 off
[ Import Virtual Machine.
Z1 Virtual Switch Manager...
12003274 V4@ B
.l Virtual SAN Manager.
4 Hardware 5 10E Controler
] Add Hardware o Edit Disk
& Bios You can add hard crves and CD/DVD drives to your IDE controler. I nspect Disk..
Boot from CD Select the type of drive you want to attach to the contraler and then cick Add. ® stopenice
. Memory P
2768108 K Remove Server
& [} Processor G Refresh
4 Virtual processors
View ,
5 s Hard Drive Hel
2005274 @ ree
1 1DE Controler 1 rsa-nw-112003274 -
5 SCS1 Controller a hard drive discor sk after
G Connect.
Checkpoints & § Nework Adapter you attach the drive to the controler. @ =
testinternal
¥ comt D S
None
13 com2 Sy Checkpoint
None -
2 Moven
Diskette Drive =
&) Export.
4 Management =T Rename
1] name
52n-11.20.0.3274 Sk Deleten.
[£2) Tntegration Services i Enable Replication.
Al services offered
7 Checkpoint Fie Location H rep

CiProgramData\Microsoft\Wiindb. .
S Smart Paging Fie Location
CifrogramData M osoftiind. .
T Atomatic Start Acton
Restart i previously running
o) Autonaticstep Acten
Save

Apply

2. Select the New Virtual Hard disk.

| rsa-nw-

v 4 Q
# Hardware || = Hard Drive
“‘ﬂ Add Hardware
1% BIOS You can change how this virtual hard disk is attached to the virtual machine. If an
Boot from €D operating system is installed on this disk, changing the attachment might prevent the
virtual machine from starting,
[ Memory .
39758 ME Controller: Location:
® P— IDE Controller 0 W | | 1 (in use) Y]
4 Wirtual processors Media
(= [ IDE Controller 0 ‘You can compact, convert, expand, merge, reconnect or shrink a virtual hard disk
# & Hard Drive by editing the associated file. Specify the full path to the file.
rsa-nw-11,2.0.0.3274.vhdx ® Virtual hard disk:
E s Hard Drive
<file= | |
B 10E Controller 1 | New | | Edit | | Inspect | | Browse... |
¢l 5CSI Contraller
E| @ Network Adapter _ () Physical hard disk:
S - [
T com1
None 0 If the physical hard disk you want to use is not listed, make sure that the
@ CoM 2 disk is offline. Use Disk Management on the physical computer to manage
None physical hard disks.
| Diskette Drive
None To remove the virtual hard disk, dick Remove, This disconnects the disk but does not
A delete the assodated file.
|| Mame
rsanw-11.2.0.0,.3274
%] Integration Services
All services offered
13| Checkpaint File Location
C:\ProgramData\Microsoft\Win. ..
éé Smart Paging File Location
C:ProgramData\Microsoftiwin... —
I Automatic Start Action
Restart if previously running i

Apply |
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3. Select VHDX as a disk format.

3] Settings for rsa-nw- © on WIN-KRMUH26561K

] !
|rsa-nw- b v| €1

¢ Hardwara [

= New Virtual Hard Disk Wizard

_,-Q?; Choose Disk Format

Before You Begin What format do you want to use for the virtual hard disk?
Choose Disk Format ) YHD
Choose Disk Type Supports virtual hard disks up to 2,040 GB in size.
Specify Name and Location ® YHDX
Configure Disk This format supports virtual disks up to 64 TB and is resilient to consistency issues that might occur
Summary from power failures. This format is not supported in operating systems earlier than Windows
Server 2012,
| < Previous | | Mext = | | Finish | | Cancel |
- Restart if previously running v
| oK | | Cancel | | Apply |

4. Select Dynamically expanding as a disk type.
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& Settings for rsa-nw- * on WIN-KRMUH26561K = =] =
rsa-nw- w ]

|@ Hardwars - | s

= New Virtual Hard Disk Wizard -

'J;‘:_j? Choose Disk Type

Befaore You Begin

Choose Disk Format

Choose Disk Type

Spedfy Name and Location

Configure Disk

What type of virtual hard disk do you want to create?

() Fixed size

This type of disk provides better performance and is recommended for servers running applications
with high levels of disk activity. The virtual hard disk file that is created initially uses the size of the
wvirtual hard disk and does not change when data is deleted or added.

Dynamically expanding

LLouEry This type of disk provides better use of physical storage space and is recommended for servers
running applications that are not disk intensive, The virtual hard disk file that is created is small
initially and changes as data iz added.

() Differencing

This type of disk is assodated in a parent-child relationship with another disk that you want to

leave intact. You can make changes to the data or operating system without affecting the parent
dik, so that you can revert the changes easily. All children must have the same virtual hard disk
format as the parent (WHD or VHDX).

| < Previous | | MNext > | | Finish | | Cancel |
" Restartif previous y running -
| oK | | Cancel | | Apply

5. Specify the Name and Location of the virtual hard disk file.
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& Settings forrsa-nw © © * on WIN-KRMUH26561K - 8] x
|rsa—nw— My V| 4 b |G

plh
@ Specify Name and Location

Before You Begin Spedfy the name and location of the virtual hard disk file.
Choose Disk Format

Mame: | Mew Virtual Hard Disk. vhdx

Choose Disk Type

Specify Name and Location Location: |C:\J..Isers\Pubhc‘,Dommentsﬂiyper-‘u”l,‘u‘irmal Hard Disks}

Configure Disk

Summary

Restart if previously running -

6. Select create a new blank virtual hard disk and specify the size.
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= Settings forrsa-nw ~  on WIN-KRMUH26561K = -

|rsa-nw- teisd V| 4 P |ﬁ

@ Configure Disk

Before You Begin ‘You can create a blank virtual hard disk or copy the contents of an existing physical disk.
Choose Digk Format ®) Create a new blank virtual hard disk

Choose Disk Type Size: GB (Maximum: 54 TB)

Specify Name and Location

- () Copy the contents of the spedified physical disk:
Configure Disk

Physical Hard Disk:

Surmmary W 1c

() Copy the contents of the spedified virtual hard disk

Path: | | | Browse...

Restart if previously running -

7. In the Summary, review the settings and click Finish.
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EH| Settings forrsa-nw- + = on WIN-KEMUH26561K =-1O

Py
rsa-nw- v g

[ Hardware [

il Mew Virtual Hard Disk Wizard -

,-\_:1;‘? Completing the New Virtual Hard Disk Wizard

Before You Begin You have successfully completed the New Virtual Hard Disk Wizard. You are about to create the
Chaose Disk Format following virtual hard disk.

Choose Disk Type Desaription:

Specify Name and Location Format:  VHDX

Canfigure Disk Type: dynamically expanding
MName: MNew Virtual Hard Disk. vhdx

Location: C:\Users\Public\Documents\Hyper-V'\Virtual Hard Disks

Size: 127 GB

To create the virtual hard disk and dose this wizard, dick Finish.

= ] (o]

Restart if previously running w

oK | | Cancel | | Apply

Add New Disk in Nutanix AHV

Perform the following steps to add a new disk to your Nutanix AHV VM.
1. Log in to the Nutanix Prism GUI.

2. From the drop-down menu, click VM and select the Table view.
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3. Select the VM that you want to add disk to and click Update.
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4. In the Update VM dialog, scroll down to the Disks section and click Add New Disk.

Jpdate VM Ly x
D":.-‘.. - A
D-ROM 3.0 SIZE >i8; CONTAINER-d A . g
DISK 1 SIZE-S00GIB. CONTAINER s x

Boot Configuration

-~
Legoacy 3 L |
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Add Dis 4 x
DISK -
Allocate on Storage Cont 1 -
SCS -
Wikijs (7.49 TiB free -
Next Available -

5. In the Add Disk dialog, do the following:
a. Select DISK in the Type field and specify other details based on your requirement.
b. Select Allocate on Storage Container in the Operations field.
c. Select SCSI as Bus Type.

6. Click Add.

7. In the Update VM dialog, click Save.
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Task 2. Storage Configurations

For storage allocations of all host types, see the Prepare Virtual or Cloud Storage topic in the Storage
Guide for RSA NetWitness® Platform 11.x.

For more information on storage configurations using the REST API, see the Configure Storage Using
the REST API topic in the Storage Guide for RSA NetWitness® Platform 11 .x.

Step 3. Install RSA NetWitness Platform

Complete the steps below to install NetWitness 11.5.

Note: Before installing the hosts make sure that the time on each host is synchronized with the time on
the NetWitness Server.

To synchronize the time do one of the following:

- Configure the NTP Server. For more information, see"Configure NTP Servers" in the System
Configuration Guide.

- Run the following commands on each hosts:

1. SSH to NW host.

2. Run the following commands.
systemctl stop ntpd
ntpdate nw-node-zero
systemctl start ndpd

This task installs:
e The 11.5.0.0 NW Server environmental platform.

e The NW Server components (that is, Admin Server, Config Server, Orchestration Server, Integration
Server, Broker, Investigate Server, Reporting Engine, Respond Server and Security server).

* A repository with the RPM files required to install the other functional components or services.

Prerequisites

Deploy your 11.5.0.0 environment:
1. Add new VM.

2. Configure storage.

3. Set up firewalls.

Install RSA NetWitness Platform

Caution: If you want to install the Endpoint Relay Server, do not run the nwsetup-tui script. Follow
the instructions in "(Optional) Installing and Configuring Relay Server" in the NetWitness Endpoint
Configuration Guide.
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IMPORTANT: In NetWitness Platform version 11.6 or later, deployment account password must
contain at least one number, one upper and lower case letter, and one special characters (!@#%",+ . )
along with the existing policy. The same password policy applies while updating deploy admin
password using nw-manage script. [f deploy admin password is changed on Primary NW Server,
It must be changed on the Warm Standby Server if it exists.

1. Log in to the host with the root credentials and run the nwsetup-tui command to set up the host.

This initiates the nwsetup-tui (Setup program) and the EULA is displayed.

Note: Use the following options to navigate the Setup prompts.

1.) When you navigate through the Setup program prompts, use the down and up arrows to move
among fields, and use the Tab key to move to and from commands (such as <Yes>, <No>, <OK>,
and <Cancel>). Press Enter to register your command response and move to the next prompt.

2.) The Setup program adopts the color scheme of the desktop or console you use to access the
host.

3.) If you specify DNS servers during the Setup program (nwsetup-tui) execution, they MUST
be valid (valid in this context means valid during setup) and accessible for the nwsetup-tui
script to proceed. Any misconfigured DNS servers cause the Setup program to fail. If you need to
reach a DNS server after setup that is unreachable during setup, (for example, to relocate a host
after setup that would have a different set of DNS Servers), see "Change Host Network
Configuration" topic in the System Maintenance Guide.

If you do not specify DNS Servers during setup (nwsetup-tui), you must select 1 The Local
Repo (on the NW Server) in the NetWitness Update Repository prompt in step 12 (the DNS
servers are not defined so the system cannot access the external repo).

By clicking “Accept”, you (the “Customer”) hereby agree, on behalf of your
company or organization, to be bound by the terms and conditions of the
End User License Agreement (the “EULA”) located at
https://www.rsa.com/content/dam/rsa/PDF/shrinkwrap-license-combined.pdf
with RSA Security LLC (“RSA”, or appropriate affiliate entity in the
relevant jurisdiction). In addition, Customer hereby agrees and
acknowledges that, if Customer chooses to host its data with any third
party or in a public cloud environment, RSA has no responsibility for the
storage or protection of any Customer data or for any associated security
breach notifications. The terms herein and in the EULA shall supersede any
relevant terms in any other agreement between the Customer and R5A. For
customers of the RSA NetWitness® products, all data analyzed in connection
herewith shall be at a cost to Customer based on RSA’'s then current

<Decline>

2. Tab to Accept and press Enter.
The Is this the host you want for your 11.7 NW Server prompt is displayed.
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You must setup an NW Server before setting up
any other NetWitness Platform components.

Is this the host you want for your 11.7 NW

Server?

3. Tab to Yes and press Enter to install 11.7 on the NW Server.
Tab to No and press Enter to install 11.7 on other component hosts.

Caution: If you choose the wrong host for the NW Server and complete the Setup, you must
restart the Setup Program (step 2) and complete steps all the subsequent steps to correct this error.

4. The Install prompt is displayed (Recover does not apply to the installation. It is for 11.7 Disaster
Recovery.).
NW Server Host prompt:

Specify the install type: Fresh
Install, Reinstall, or Warm Standby
NW Server Install.

I Install (Fresh Install)

Recover (Reinstall)
3 Install (Warm/Standby)

< Exit >

Other Component Hosts, the prompt is the same, but does not include option 3 Install
(Warm/Standby)

5. Press Enter. Install (Fresh Install) is selected by default.
The System Host Name prompt is displayed.
NW Server prompt:

System Host Name o

Please accept or update the system
host name:

[ <nwserver-host-name>

OK > <Cancel>

Other Component Hosts prompt says <non-nwserver-host-name>

nn

Caution: If you include "." in a host name, the host name must also include a valid domain name.

Press Enter if want to keep this name. If not, edit the host name, tab to OK, and press Enter to
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change it.

6. This step applies only to NW Server hosts.
The Master Password prompt is displayed.

Eale e e i o e e

The following list of characters are supported for Master Password and Deployment Password:
Symbols: ! @ # % ~ +
¢ Numbers: 0-9

¢ Lowercase Characters: a-z

e Uppercase Characters: A-Z

No ambiguous characters are supported for Master Password and Deployment Password. For
example:

space { } [J()/\"" "~ <>-
Type the Password, down arrow to Verify, retype the password, tab to OK, and press Enter.

7. This step applies to both NW Server hosts and component hosts.
The Deployment Password prompt is displayed.

ol e b o o o o i

Type the Password, down arrow to Verify, retype the password, tab to OK, and press Enter.
8. One of the following conditional prompts is displayed.
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¢ [f the Setup program finds a valid IP address for this host, the following prompt is displayed.
IP Address <IP-address> is
currently assigned to this
host. Do you still want to
change network settings?

< Yes >

Press Enter if you want to use this IP and avoid changing your network settings. Tab to Yes and
press Enter if you want to change the IP configuration on the host.

¢ [fyou are using an SSH connection, the following warning is displayed.

Note: If you connect directly from the host console, the following warning is not displayed.

NetWitness Platform Network Configuration
WARNING - You are currently running the
NetWitness installation over an SSH
connection. Network configuration
updates will result in restarting the
network service which may cause the SSH
session to terminate.

Press Enter to close warning prompt.

¢ If the Setup Program finds an IP configuration and you choose to use it, the Update Repository
prompt is displayed. Go to step 12 and complete the installation.

e [f the Setup Program did not find an IP configuration or if you choose to change the existing IP
configuration, the Network Configuration prompt is displayed.

Caution: Only select "Use DHCP" as an IP address configuration for the NW Server if DHCP
issues static [P addresses.

NetWitness Platform Network Configuration q
The IP address of the NW Server is used by all other NetWitness
Platform components. RSA recommends that you use a Static IP
Configuration for the NW Server IP address over DHCP. After the
IP address is assigned, record it for future use. You need this
address to set up other components.

Select an IP address configuration for the NW Server.

I Static IP Configuration
2 TUse DHCP

< Exit >

Tab to OK and press Enter to use Static IP.
If you want to use DHCP, down arrow to 2 Use DHCP and press Enter.
The Network Configuration prompt is displayed.
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9. Down arrow to the network interface you want, tab to OK, and press Enter. If you do not want to
continue, tab to Exit.
The following Static IP Configuration prompt is displayed.

10. Type the configuration values, tab to OK, and press Enter. If you do not complete all the required
fields, an A11 fields are required error message is displayed (Secondary DNS Server and
Local Domain Name fields are not required). If you use the wrong syntax or character length for any
of the fields, an Tnvalid <field-name> error message is displayed.

Caution: If you select DNS Server, make sure that the DNS Server is correct and the host can
access it before proceeding with the installation.

11. The Use Network Address Translation (NAT) prompt is displayed.

For the NW Server, tab to No and press Enter.
For component hosts, if this host requires the use of NAT-based addresses to communicate with the
NW Server, tab to Yes. Otherwise, tab to No and press Enter.
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12. The Update Repository prompt is displayed.

For the NW Server:
¢ Press Enter to choose the Local Repo.

¢ If you want to use an external repo, down arrow to External Repo, tab to OK, and press Enter. If
you select 1 The Local Repo (on the NW Server) in the Setup program, make sure that you have
the appropriate media attached to the host (media that contains the ISO file, for example a build
stick) from which it can install NetWitness 11.7. If the program cannot find the attached media,
you receive the following prompt.

e Ifyou select 2 An External Repo (on an externally-managed server), the Ul prompts you for a
URL. The repositories give you access to RSA updates and CentOS updates. Refer to "Appendix
B. Create an External Repo" in this guide for instructions on how to create this repo and its

external repo URL so you can enter it in the following prompt.

S
L

Enter the base URL of the NetWitness external repo and click OK. The Start Install prompt is
displayed.

For component hosts:

¢ Select the same repo that you selected when you installed the NW Server host and follow the steps
above.
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e The NW Server IP Address prompt is displayed.

Type the NW Server IP address. Tab to OK and press Enter.
13. The Disable firewall prompt is displayed.

Tab to No (default), and press Enter to use the standard firewall configuration.

To disable the standard firewall configuration, tab to Yes, and press Enter.

If you select Yes, confirm your selection(select Yes again) or select No to use the standard firewall
configuration.

14. The Start Install prompt is displayed.
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15. Press Enter to install 11.7.
When Installation complete is displayed, you have installed 11.7 on this host.

Note: Ignore the hash code errors similar to the errors shown in the following figure that are
displayed when you initiate the nwsetup-tui command. Yum does not use MDS5 for any security
operations so they do not affect the system security.

1on :nothing)

de for hash md5 was not found.

s1_constructor

16. (Optional) If your system configuration requires that a component host must use a NAT IP address to
reach the NW Server host, you must configure the NAT IP address of the NW Server by running the
following command:
nw-manage --update-host --host-id <NW Server Host UUID> --ipvé4-public <NAT
IP address>

Set Up ESA Hosts

After you install your NW Server and component hosts, follow these steps to set up your ESA hosts.

 Install your primary ESA host following the instructions in "Install 11.7 on the NetWitness Server
(NW Server) Host and Other Component Hosts" in this guide, and install the ESA Primary service

. . . . . = Install
on it after you finish the Set Up program in the UI in K428 (Admin) > Hosts > £= '''=t=

Install Services
Select the appropriate category and click Install to complete the

installation process. If you select and install the wrong category,
you must reimage the host.

Version: 11.6.0.0 Hardware
Platform:
Category: ESA Primary v
The following servi Analyst Ul s host:
Archiver

= Contexthub S
= ESA Correlatic Broker

Concentrator

Endpoint

Endpoint Broker

- Endpoint Log Hybrid = 1] Install
ESA Primary
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e (Conditional) If you have a secondary ESA host, install it and install the ESA Secondary service on it
a —
after you finish the Set Up program in the Ul in (Admin) > Hosts > £ [nstall =

Install Services

Select the appropriate category and click Install to complete the
installation process. If you select and install the wrong category,
you must reimage the host.
Version: 11.6.0.0 Hardware
Platform:
Category: ESA Secondary v
The following servi Analyst Ul s host:
= ESA Correlatic Archiver
Broker
Concentrator
Endpoint
Endpoint Broker

- Endpoint Log Hybrid =~ /2% Install
ESA Primary

ESA Secondary

Log Collector

Install Component Services on Hosts

After you have installed NW Server and component hosts, and set up your ESA hosts, follow these steps
to install component services, such as Decoders and Concentrators, on your host systems.

1. Install a component service on the host.

Q
a. Log into NetWitness and go to (Admin) > Hosts.
The New Hosts dialog is displayed with the Hosts view grayed out in the background.

Note: If the New Hosts dialog is not displayed, click Discover in the Hosts view toolbar.

b. Select the host in the New Hosts dialog and click Enable.
The New Hosts dialog closes and the host is displayed in the Hosts view.

c. Select that host in the Hosts view and click 2= 'nstall =
The Install Services dialog is displayed.
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d. Select the appropriate host type (for example, Concentrator) in Category and click Install.

Install Services

Select the appropriate category and click Install to complete the
installation process. If you select and install the wrong category,
you must reimage the host.

Version: 11.6.0.0 Hardware
Platform:

Category: Concentrator v

The following servi| Analyst Ul s host:
= Concentrator Archiver
Broker

Concentrator

Endpoint

Endpoint Broker
Endpoint Log Hybrid &S] Install
ESA Primary

Complete Licensing Requirements

Complete licensing requirements for installed services. See the NetWitness Platform 11.7 Licensing
Management Guide for more information. Go to the NetWitness Documents - All Versions to find all
RSA NetWitness Platform 11.x documents.

(Optional) Install Warm Standby NW Server

Refer to "Warm Standby NW Server Host" under "Deployment Option Setup Procedures” in the
Deployment Guide for RSA NetWitness Platform 11.7 for instructions on how to set up a Warm Standby
NW Server.

(Optional) Boot NetWitness 11.4 EC2 Instance using c5 Instance
Types

Following are the steps:

1. Deploy an EC2 instance using NW 11.4 Lite/Full AMI (RSANW-11.4.0.0.14000-Full, ami-
002bbbd3748876253).

2. Select a non-nitro based instance type. For example, " m4.large " and boot the instance.
3. Install the package " dracut-config-generic " and rebuild the initramfs image.

4. For environment without internet connection, copy the provided RPM package to target 11.4 EC2
instance and install it.

5. Shutdown or stop the EC2 instance. Ensure that the instance shutdown behavior is set to "Stop" and
not " Terminate. ".

6. Change the instance type of existing EC2 instance to nitro-based c5 types (For example, c5.4xlarge)
and start the EC2 instance.

7. The EC2 instance boots successfully now, passing the system and instance status health checks.
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(P New EC2 Experience

(ETLCHILE LR ) Connect  Actions v

Leam more A O % 0
EC2 Dashboard ), Name : RSANW Add filter [~] 1to20f2
Events
- Name Instance ID Instance Type ~ Availability Zone - Instance State - Status Checks Alarm Statu
ags
Limits B  RSANW-11.4.0.0-ESAPRIMARY-FULL 1-054155778f27bf42d @ running @ 212 checks passed None
- RSANW-11.4.0.0-ADMINSERVER-FULL i-Oceca4282af86dd3 @ running @ 212 checks passed None
Instances d
Instance: | i-054155778f27bf42d (RSANW-11.4.0.0-ESAPRIMARY-FULL)  Private IP: 172.24.184.213 _B Q=]

Instance Types
Launch Templates
Spot Requests
Savings Plans
Reserved Instances
Dedicated Hosts
Scheduled Instances

Capacity Reservations

AMIs

Volumes
Snapshots

Lifecycle Manager

Description Status Checks

Instance ID
Instance state
Instance type

Finding

Private DNS

Private IPs
Secondary private IPs
VPC ID

Platform

Platform details
Usage operation
Source/dest. check

Monitoring | Tags

i-054155778f27bf42d
running

c5.xlarge

Opt-in to AWS Compute Optimizer for recommendations.

Learn more
ip-172-24-184-213.ec2.internal
172.24.184.213

Vpc-3415097 (AWS-ASOC-USEast)
Other Linux

Linux/UNIX

Runinstances

True

T2/T3 Unlimited -

Public DNS (IPv4) -
IPv4 Public IP -
IPV6IPs -

Elastic IPs

Availability zone
Security groups
Scheduled events
AMI ID

Subnet ID
Network interfaces

us-east-1a

allow-all-traffic. view inbound rules. view outbound rules
No scheduled events

RSANW-11.4.0.0.14000-Full (ami-002bbbd3748876253)
subnet-063b797bd1a7d9507 (Demo)

ethd

IAMrole -

Key pair name -

Owner

481211520927

Note: Once the instance is moved to c5 instance types and booted successfully, the system will
remain fixed in c¢5 instance state and cannot be reverted back to m4 instance types.

Step 4. Configure Host-Specific Parameters

Certain application-specific parameters are required to configure log ingest and packet capture in the
Virtual Environment.

Configure Log Ingest in the Virtual Environment

Log ingest is easily accomplished by sending the logs to the IP address you have specified for the

Decoder. The Decoder's management interface allows you to then select the proper interface to listen for
traffic on if it has not already selected it by default.

Configure Packet Capture in the Virtual Environment

There are two options for capturing packets in a VMware environment. The first is setting your vSwitch
in promiscuous mode and the second is to use a third-party Virtual Tap.

Set a vSwitch to Promiscuous Mode

The option of putting a switch whether virtual or physical into promiscuous mode, also described as a
SPAN port (Cisco services) and port mirroring, is not without limitations. Whether virtual or physical,
depending on the amount and type of traffic being copied, packet capture can easily lead to over
subscription of the port, which equates to packet loss. Taps, being either physical or virtual, are designed
and intended for loss less 100% capture of the intended traffic.

Promiscuous mode is disabled by default, and should not be turned on unless specifically required.
Software running inside a virtual machine may be able to monitor any and all traffic moving across
a vSwitch if it is allowed to enter promiscuous mode as well as causing packet loss due to over
subscription of the port..

To configure a portgroup or virtual switch to allow promiscuous mode:
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1. Log on to the ESXi/ESX host or vCenter Server using the vSphere Client.

Select the ESXi/ESX host in the inventory.

Select the Configuration tab.

In the Hardware section, click Networking.

Select Properties of the virtual switch for which you want to enable promiscuous mode.

Select the virtual switch or portgroup you want to modify, and click Edit.

NS kv

Click the Security tab. In the Promiscuous Mode drop-down menu, select Accept.

Use of a Third-Party Virtual Tap

Installation methods of a virtual tap vary depending on the vendor. Please refer to the documentation
from your vendor for installation instructions. Virtual taps are typically easy to integrate, and the user
interface of the tap simplifies the selection and type of traffic to be copied.

Virtual taps encapsulate the captured traffic in a GRE tunnel. Depending on the type you choose, either
of these scenarios may apply:

e An external host is required to terminate the tunnel, and the external host directs the traffic to the
Decoder interface.

* The tunnel send traffic directly to the Decoder interface, where NetWitness handles the de-
encapsulation of the traffic.
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Step 5. Post Installation Tasks

This topic contains the tasks you complete after you install 11.5.
e Event Stream Analysis (ESA)

e RSA NetWitness Endpoint

e RSA NetWitness UEBA

Go to the NetWitness Documents - All Versions to find all RSA NetWitness Platform 11.x documents.

Event Stream Analysis (ESA)

Configure Meta Keys on New ESA Hosts to Match Upgraded ESA Hosts in the

Same NetWitness Platform Network

Note: If you are upgrading from version below 11.4.x.x, make sure that meta keys on new ESA hosts
are updated to match upgraded ESA Hosts in the Same NetWitness Platform Network.

If you have one or more ESA hosts in a NetWitness Platform network, which were upgraded from a
version before 11.3.0.2 to 11.6, and you add a new ESA host, you must configure the meta keys on the
new ESA host to match the other ESA hosts. All ESA Correlation services on the same NetWitness
Platform network must have the same Meta Key configurations.

1. For each ESA Correlation service on an upgraded ESA host and for the ESA Correlation service on
the newly installed ESA host:

A
a. Open a new tab, go to (Admin) > Services, and in the Services view, select the ESA

Correlation service and then select ﬂ © > View > Explore.
b. In the Explore view node list for the ESA Correlation service, select correlation > stream.
2. Ensure that the multi-valued and single-valued meta key values are the same on each of the
upgraded ESA Correlation services.

3. Ensure that the multi-valued and single-valued meta key values on the newly installed ESA
host are the same as those on the upgraded services.

4. To apply any changes on the ESA Correlation services, go to (Configure) > ESA Rules and
click the Settings tab. In the Meta Key References, click the Meta Re-Sync (Refresh) icon (¥ ).

5. If you updated the ESA Correlation services, redeploy the ESA rule deployments.

For more information, see "Update Your ESA Rules for the Required Multi-Value and Single-Value
Meta Keys" in the ES4 Configuration Guide.
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RSA NetWitness Endpoint

The tasks in this section only apply to customers that use the RSA NetWitness Endpoint component of
NetWitness Platform.

Install Endpoint Log Hybrid

Depending on the number of agents and the location of the agents, you can choose to deploy a single
Endpoint Log Hybrid host or multiple Endpoint Log Hybrid hosts. To deploy a host, you provision it and
install a category on it.

o Single Endpoint Log Hybrid host - Deploy NetWitness Server host, Endpoint Log Hybrid host, and
ESA host or hosts.

e Multiple Endpoint Log Hybrid hosts - Deploy NetWitness Server host, ESA host or hosts, Endpoint
Log Hybrid hosts. For a consolidated view of all endpoint data from multiple Endpoint Log Hybrid
hosts, install the Endpoint Broker.

Note: RSA recommends that you co-locate the Endpoint Broker on the NetWitness Broker host.
However, you can deploy the Endpoint Broker on a separate host or co-locate it on the Endpoint
Log Hybrid.

Note: You must plan to scale your ESA deployment to support multiple Endpoint Log Hybrid
hosts.

Follow these steps to deploy an Endpoint Log Hybrid host.
Complete the following steps first:

* For a physical host, complete steps 1 - 16 in "Install RSA NetWitness Platform" under Installation
Tasks in the Physical Host Installation Guide for NetWitness Platform 11.5

e For a virtual host, complete steps 1 - 16 in "Step 4. Install RSA NetWitness Platform" under Install
NetWitness Platform Virtual Host in Virtual Environment in the Virtual Host Installation Guide for
NetWitness Platform 11.5

After NetWitness Platform is installed, complete these steps to set up the Endpoint Log Hybrid hosts:

1. Log into NetWitness Platform and click K& (Admin) > Hosts.
The New Hosts dialog is displayed with the Hosts view grayed out in the background.

Note: If the New Hosts dialog is not displayed, click Discover in the Hosts view toolbar.

2. Select the host in the New Hosts dialog and click Enable.
The New Hosts dialog closes and the host is displayed in the Hosts view.

3. Select that host in the Hosts view (for example, Endpoint) and click 2 Install .
The Install Services dialog is displayed.

4. Select the Endpoint Log Hybrid category and click Install.

5. Make sure that the Endpoint Log Hybrid service is running.
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6. Configure Endpoint Meta forwarding.

See the Endpoint Configuration Guide for instructions on how to configure Endpoint Meta
forwarding.

7. Deploy the ESA Rules from the Endpoint Rule Bundle. For more information, see "Deploy Endpoint
Risk Scoring Rules on ESA" section in the ESA Configuration Guide.

Note: The Endpoint IIOCs are available as OOTB Endpoint Application rules.

8. Review the default policies and create groups to manage your agents. See Endpoint Configuration
Guide.

Note: In 11.3 or later, agents can operate in Insights or Advanced mode depending on the policy
configuration. The default policy enables the agent in an advanced mode. If you want to continue
to use the Insights agent, before updating, review the policy, and make sure that the Agent mode is
set to Insights.

9. Install the Endpoint Agent. You can install an Insights (free version) or an Advanced agent
(licensed). See Endpoint Agent Installation Guide for detailed instructions on how to install the
agent.

Note: You can migrate the Endpoint Agent from 4.4.0.x to 11.5. For more information, see the
NetWitness Endpoint 4.4.0.x to NetWitness Platform 11.5 Migration Guide.

Configuring Multiple Endpoint Log Hybrids
Follow these steps to install another Endpoint Log Hybrid.
Complete the following steps first:

e For a physical host, complete steps 1 - 16 in "Install RSA NetWitness Platform" under Installation
Tasks in the Physical Host Installation Guide for NetWitness Platform 11.5

e For a virtual host, complete steps 1 - 16 in "Step 4. Install RSA NetWitness Platform" under Install
NetWitness Platform Virtual Host in Virtual Environment in the Virtual Host Installation Guide for
NetWitness Platform 11.5

After NetWitness Platform is installed, complete these steps to set up the Endpoint Log Hybrid hosts:

1. Create a directory mkdir -p /etc/pki/nw/nwe-ca.

2. Copy the following certificates from the first Endpoint Log Hybrid to the second Endpoint Log
Hybrid:

Note: RSA recommends that you copy certificates from Endpoint Log Hybrid to secondary
Endpoint Log Hybrid CentOS to Windows using the SCP command to avoid any corruption caused
by Antivirus or third-party tools.

/etc/pki/nw/nwe-ca/nwerootca-cert.pem

/etc/pki/nw/nwe-ca/nwerootca-key.pem

3. Repeat steps 1-5 in Install Endpoint Log Hybrid.
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(Optional) Configure an Endpoint Service on an Existing Log Decoder Host

You can install an Endpoint service category on an existing Log Decoder host. For an overview of

installing service categories on hosts, see "Hosts and Services Set Up Procedures" in the Host and

Services Getting Started Guide. Go to the NetWitness Documents - All Versions to find all RSA

NetWitness Platform 11.x documents.

* If you have an existing Endpoint Log Hybrid, you must copy certificates from that Endpoint Hybrid
host to the Log Decoder before you install the Endpoint service category on the Log Decoder.

e If you do not have an Endpoint Log Hybrid host, you do not need to copy over the certificates before
you install the Endpoint service category on the Log Decoder.

Do You Need to Install an Endpoint Service onto Separate Hardware

If you are only using NW Platform for collecting and analyzing logs, you can co-locate your Endpoint
Server on the same physical hardware as your Log Decoder. For more information, see the Prepare
Virtual or Cloud Storage topic in the Storage Guide for RSA NetWitness Platform 11.x.

If you exceed these guidelines, the amount of disk space usage and CPU might become so high as to
create alarms for your Endpoint Server in Health and Wellness. If you notice this, and are running both
log collection and EDR scans, you can use Throttling to control the amount of data coming into the Log
Decoder.

If that doesn't help, RSA recommends that you move your Endpoint Server onto separate hardware from
that used by your Log Decoder.

Install an Endpoint Service Category on an Existing Log Decoder

To install an Endpoint service category on an existing Log Decoder if you have an existing Endpoint
Log Hybrid:

1. Create a directory mkdir -p /etc/pki/nw/nwe-ca.

2. Copy the following certificates from the first Endpoint Log Hybrid to the Log Decoder on which you
are going to install the additional Endpoint service category.

Note: RSA recommends that you copy certificates from Endpoint Log Hybrid to secondary
Endpoint Log Hybrid using the SCP command to avoid any corruption caused by Antivirus or
third-party tools.

/etc/pki/nw/nwe-ca/nwerootca-cert.pem

/etc/pki/nw/nwe-ca/nwerootca-key.pem
3. Log into NetWitness Platform and click K42l (Admin) > Hosts.

4. Select the Log Decoder host in the Hosts view and click & Install @
The Install Services dialog is displayed.
5. Select the Endpoint category and click Install.

To install an Endpoint service category on an existing Log Decoder if you do not have an existing
Endpoint Log Hybrid:
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1. Log into NetWitness Platform and click Kzl (Admin) > Hosts.

2. Select the Log Decoder host in the Hosts view and click 2 Install @
The Install Services dialog is displayed.
3. Select the Endpoint category and click Install.

RSA NetWitness UEBA

The tasks in this section only apply to customers that use the RSA UEBA component of NetWitness
Platform.

Install UEBA

To set up NetWitness UEBA in NetWitness Platform 11.5, you must install and configure the
NetWitness UEBA service.

The following procedure shows you how to install the NetWitness UEBA service on a NetWitness
UEBA Host Type and configure the service.

1. For:

¢ A physical host, complete steps 1 - 16 in "Install RSA NetWitness Platform" under "Installation
Tasks" in the Physical Host Installation Guide for NetWitness Platform 11.5.

e A virtual host, complete steps 1 - 16 in "Step 4. Install RSA NetWitness Platform" in the Virtual
Host Installation Guide for NetWitness Platform 11.5.

Note: The Kibana and Airflow webserver User Interface password is the same as the deploy admin
password. Make sure that you record this password and store it in a safe location.

2. Log into NetWitness Platform and go to K4:M (Admin) > Hosts.
The New Hosts dialog is displayed with the Hosts view grayed out in the background.

Note: If the New Hosts dialog is not displayed, click Discover in the Hosts view toolbar.

3. Select the host in the New Hosts dialog and click Enable.
The New Hosts dialog closes and the host is displayed in the Hosts view.

4. Select that host in the Hosts view (for example, UEBA) and click £ Install &
The Install Services dialog is displayed.

5. Select the UEBA Host Type and click Install.
6. Make sure that the UEBA service is running.

7. Complete licensing requirements for NetWitness UEBA.
See the Licensing Management Guide for more information.
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Note: NetWitness Platform supports the User and Entity Behavior Analytics License (UEBA). This
license is used based on the number of users. The Out-of-the-Box Trial License is a 90-day trial
license. In case of UEBA licenses, the 90-day trial period begins from the time the UEBA service
deployed on the NetWitness Platform product.

Configure NetWitness UEBA
To start running UEBA:

1. Define the following parameters: data schemas, data source (NetWitness Broker or Concentrator) and
start date.

a. Define UEBA schemas:
Choose schemas from the following list:

AUTHENTICATION, FILE, ACTIVE_DIRECTORY, PROCESS, REGISTRY and TLS.

Note: The TLS packet requires adding the hunting package and enabling the JA3 feature. For
more information regarding events that each schema contains, see the NetWitness UEBA
Configuration Guide.

b. Define the data source:
If your deployment has multiple Concentrators, we recommend that you assign a Broker at the
top of your deployment hierarchy for the NetWitness UEBA data source.

c. Define the UEBA start-date:

Note: The selected start date must contain events from all configured schemas.

RSA recommends that the UEBA start date is set to 28 days earlier than the current date. For
UEBA systems that intend to process TLS data, you must make sure that the start date is set to no
later than 14 days earlier than the current date.

2. . Create a user account for the data source (Broker or Concentrator) to authenticate to the data.

a. Log into NetWitness Platform.

QA
b. Goto (Admin) > Services.

c. Locate the data source service (Broker or Concentrator).
Select that service, and select o (Actions) > View > Security.

d. Create a new user and assign the “Analysts” role to that user.
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The following example shows a user account created for a Broker.

HOSTS  SERVICES

#. Change Service | B3 rsa-nw-1150-5A - Broker | Security =

Roles Settings

+ - % i
' User Information
u:
sErmame MName Username
Lo Broker Broker
admin Pazzword Confirm Paszword
Email Description

test@rsa.com

User Settings
Auth Type Care Query Timeout

MNetWitness Platform E ~

Role Membership

| Grou ps
] Administrators
| Aggregation
#  Analysts
| Data_Privacy_Officers
| Malware_Analysts
| Operators

| 20C_Managers

SSH to the NetWitness UEBA server host.

4. Set the appropriate parallelism value:
If the UEBA system runs on VM, update the airflow parallelism value to be 64 by running the

following command:
sed -1 "s|parallelism = 256|parallelism = 64|g"
/var/netwitness/presidio/airflow/airflow.cfg

5. Submit the following commands with the above parameters that you already defined.
/opt/rsa/saTools/bin/ueba-server-config -u <user> -p <password> -h <host> -

o <type> -t <startTime> -s <schemas> -v -e <argument>

Where:
m Variable Description
—u <user> User name of the credentials for the Broker or
Concentrator instance that you are using as a data
source.
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N

P <password> Password of the credentials for the Broker or
Concentrator instance that you are using as a data
source. The following special characters are supported
in a password.

IM#SSE () *+, —;<=>2@ [\]1"_ "\ (I}

If you want to include a special character or special
characters, you must delimit the password with an
apostrophe sign, for example:

sh /opt/rsa/saTools/bin/ueba-server-
config -u brokeruser -p '!"UHfz?Q@ExMn#$'
-h 10.64.153.104 -t 2018-08-01T00:00:002Z
-s 'AUTHENTICATION FILE ACTIVE DIRECTORY
TLS PROCESS REGISTRY' -o broker -v

-h <host> IP address of the Broker or Concentrator used as the
data source. Currently, only one data source is
supported.

-0 <type> Data source host type (broker or concentrator),

-t <startTime> Historical start time as of which you start collecting

data from the data source in YYYY-MM-DDTHH-
MM-SSZ format (for example, 2018-08-
15T00:00:00Z).

Note: The script interprets the time you enter as UTC
(Coordinated Universal Time) and it does not adjust
the time to your local time zone.

-s <schemas> Array of data schemas. If you want to specify multiple
schemas, use a space to separate each schema (for
example, AUTHENTICATION FILE ACTIVE _
DIRECTORY PROCESS REGISTRY TLS).

-v verbose mode,

-e <argument> Boolean Argument. This enables the UEBA indicator
forwarder to Respond.

Note: If your NetWitness deployment includes an
active Respond server, you can transfer NetWitness
UEBA indicators to the Respond server and create
incidents by enabling the indicator forwarder, from
this data. For more information on how to enable the
NetWitness UEBA incidents aggregation, see Step 5.
Post Installation Tasks.

6. If you are deploying a hot fix on 11.x.x.x version, you must do the following:

a. Run the presidio-upgrade DAG.

59 Install NetWitness Platform Virtual Host in Virtual Environment



Virtual Host Installation Guide

b. Press the play sign next to the DAG and then click the trigger button.

7. Set the appropriate "Boot Jar Pools" slots:

« Virtual Appliance: If the UEBA system is running on VM and update the spring boot jar
pool and the retention spring boot jar pool slots values to 22.
To update the “Spring Boot Jar Pools” slots, Go to the Airflow main page, tap the “Admin” tab at
the top bar and tap “Pools”.

a. To access the Airflow Ul, go to https://<UEBA host>/admin and enter the credentials.
User: admin
Password: The environment deploy admin password

b. Click on the pencil mark of the polls to update the slot values.

DAGs  DataProfling-  Browse=  Admi - Aot

uuuuuuuu

Enable Access Permission for the NetWitness UEBA User Interface

After you install NetWitness UEBA 11.5, you need to assign the UEBA_Analysts and Analysts roles to
the UEBA users. For more information, see 'Assign User Access to UEBA' topic in the NetWitness
UEBA Configuration Guide. After this configuration, UEBA users can access the Investigate > Users
view.

Note: To complete NetWitness UEBA configuration according to the needs of your organization, See
the RSA NetWitness UEBA Configuration Guide.

Deployment Options

NetWitness Platform has the following deployment options. See the NetWitness Deployment Guide for
detailed instructions on how to deploy these options.

* Analyst User Interface - gives you access to a subset of features in the NetWitness Platform UI that
you can set up in individual locations when you deploy NetWitness Platform in multiple locations. It
is designed to reduce latency and improve the performance that can occur when accessing all
functionality from the Primary User Interface on the NW Server Host (Primary UI).

* Group Aggregation - configures multiple Archiver or Concentrator services as a group and share the
aggregation tasks between them.

e New Health and Wellness Search - New Health and Wellness is an advanced monitoring and
alerting system that provides insights on the operational state of the host and services in your
deployment, and helps identify potential issues.

¢ Second Endpoint Server - deploys a second Endpoint Server.
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Appendix A. Troubleshooting

This section describes solutions to problems that you may encounter during installations and upgrades. In
most cases, NetWitness creates log messages when it encounters these problems.

Note: If you cannot resolve an upgrade issue using the following troubleshooting solutions, contact

Customer Support (https://community.netwitness.com/t5/support-information/how-to-contact-
netwitness-support/ta-p/563897).

This section has troubleshooting documentation for the following services, features, and processes.

e Command Line Interface (CLI)

e Event Stream Analysis

Go to the NetWitness Documents - All Versions to find all RSA NetWitness Platform 11.x documents.
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Command Line Interface (CLI)

Command Line Interface (CLI) displays: "Orchestration failed."

Mixlib::ShellOut::ShellCommandFailed: Command execution failed.
STDOUT/STDERR suppressed for sensitive resource
in/var/log/netwitness/config-management/chef-solo.log

Entered the wrong deploy_admin password in nwsetup-tui,

Retrieve your deploy admin password.

1. SSH to the NW Server host.
security-cli-client --get-config-prop --prop-hierarchy
nw.security-client --prop-name deployment.password

SSH to the host that failed.

2. Run the nwsetup-tui again using correct deploy admin password.

ERROR com.rsa.smc.sa.admin.web.controller.ajax.health.
AlarmsController - Cannot connect to System Management Service

NetWitness sees the Service Management Service (SMS) as down after successful
upgrade even though the service is running.

Restart SMS service.
systemctl restart rsa-sms

You receive a message in the User Interface to reboot the host after you update and
reboot the host offline.

[0 sA server IP-Address n version-number Reboot Host

You cannot use CLI to reboot the host. You must use the User Interface.

Reboot the host in the Host View in the User Interface.
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Event Stream Analysis

For ESA Correlation troubleshooting information, see the Alerting with ESA Correlation Rules User

Guide.
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Appendix B. Silent Installation Using CLI

You can use the following Command Line Interface commands to run the installation script (nwsetup-
tui) without getting prompted for inputs. This enables you to automate the installation of a host by
supplying response to the scripts prompts through the command line.

1. After you have created a base image on the host, log in to the host with the root credentials.

2. Submit the nwsetup-tui script with the --silent command and the arguments that you want to
apply.

The following command string is an example of how you would install a basic NW Server host.

nwsetup-tui --silent --is-head=true --host-name=new-host --master-
pass=netwitness --deploy-pass=netwitness --repo-type=1 --custom-
firewall=false --ip-override=false --eula=true

Note: In NetWitness Platform version 11.6 or later, deployment account password must contain at
least one number, one upper and lower case letter, and one special characters (!@#%",+ . ) along with
the existing policy. The same password policy applies while updating deploy admin password using
nw-manage script.

If deploy admin password is changed on Primary NW Server, It must be changed on the Warm
Standby Server if it exists.

3. (Conditional - For Component Hosts Only) Install the appropriate service Category on the newly
provisioned host in the NetWitness Platform Hosts view.

A
a. Log into NetWitness and go to (Admin) > Hosts.
The New Hosts dialog is displayed with the Hosts view grayed out in the background

Note: If the New Hosts dialog is not displayed, click Discover in the Hosts view toolbar.

b. Select the host in the New Hosts dialog and click Enable.
The New Hosts dialog closes and the host is displayed in the Hosts view.

c. Select that host in the Hosts view (for example, Event Stream Analysis) and click & Install @

The Install Services dialog is displayed.

d. Select the appropriate host type in Category and click Install.

Arguments
m
-~help-install-opts Display all the arguments in this table.
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I

--eula Accept or decline the End User License Agreement (EULA).
Specify:

e true (default) to accept the agreement

e false to decline it and cancel the installation.

For example: --eula=true

--is-head Designate the host as the NW Server host or a component host.
Specity:
* true for NW Server host.

e false for Component host.

For example: --is-head=true

-—host-name Specify new hostname. If you do not specify this argument,
NetWitness Platform retains the existing hostname.

For example: --host-name=<hostname>

—-master-pass Enter master password. For example:
--master-pass=<password>

~—deploy-pass Enter deployment password. For example:
—-—-deploy-pass=<password>

--iface-name Specify network interface.

For example: --iface-name=eth0

--ip-override Accept or override IP address found for this host or change the
IP configuration found on the host. Specify:

e true provide IP address.

e false use [P address found on the host.

For example: --ip-override=false
-—ip-type Select ip address configuration type. Specify:

e 1 Static [P Configuration)

e 2 DCHP

For example: --ip-type=1
--ip-addr For Static IP configuration, enter [P Address for static address.

For example: --ip-addr=<ip-address>

--ip-netmask For Static IP configuration, enter Subnet Mask for static address.
For example:
-—-ip-gateway=<subnet-mask>
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e o

--ip-gateway For Static IP configuration, enter default gateway for static

address. For example:
--ip-gateway=<default-gateway>

--ip-nameserver IP address assigned to DNS server.
--ip-nameserver=<ip-address>

-~ip-nameserver-secondary  Qptional - IP address assigned to a secondary DNS server.
For example: --ip-nameserver-secondary=<ip-address>

-—ip-domain For Static IP configuration, enter Local Domain Name for static

address. For example:
--ip-domain=<default-gateway>

——repo-type Select type of update repository. Specify:
e 1 Local repository

» 2 External repository
For example: --repo-type=1

--repo-url For an external update repository, specify the url of the

repository. For example:
--repo-url=<url>

-~head-ip For a component host, specify I[P Address of the NW Server.

For example: --head-ip=<ip-address>

--custom-firewall Disable default firewall configuration and use your custom
configuration. Specify:

* true use custom firewall configuration.

* false use default firewall configuration.

For example: --custom-firewall=true

—-use-nat Configure the host to use Network Address Translation (NAT)
based IP addresses:

e true use NAT IPs to connect to other hosts

e false do not use NAT IPs to connect to other hosts (default)

For example: --use-nat=false
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Appendix C. Virtual Host Recommended System

Requirements

The following tables list the vCPU, vRAM, and Read and Write IOPS recommended requirements for
the virtual hosts based on the EPS or capture rate for each component.

* Storage allocation is covered in Step 3 “Configure Databases to Accommodate NetWitness”.

¢ VRAM and vCPU recommendations may vary depending on capture rates, configuration and content
enabled.

¢ The recommendations were tested at ingest rates of up to 25,000 EPS for logs and two Gbps for
packets, for non SSL.

e The vCPU specifications for all the components listed in the following tables are
Intel Xeon CPU @2.59 Ghz.

e All ports are SSL tested at 15,000 EPS for logs and 1.5 Gbps for packets.

Note: The above recommended values might differ for 11.5.0.0 installation when you install and try
the new features and enhancements.

IMPORTANT: The recommended configuration provided serves as a general reference and supports a
standard deployment at the suggested data rates and specified architecture. However, the actual values
may vary depending on the specific deployment and usage scenario.

Scenario One

The requirements in these tables were calculated under the following conditions.
¢ All the components were integrated.
e The Log stream included a Log Decoder, Concentrator, and Archiver.

o The Packet Stream included a Network Decoder and Concentrator.

e The background load included hourly and daily reports.

e Charts were configured.

Note: Intel x86 64-bit chip architecture is 2.599 GHz or greater speed per core.

Log Decoder

2 500 6 cores 32 GB
5,000 8 cores 32 GB 100 100
7,500 10 cores 32 GB 150 150

67 Appendix C. Virtual Host Recommended System Requirements




Virtual Host Installation Guide

Network Decoder

4 cores 32 GB
100 4 cores 32 GB 50 250
250 4 cores 32 GB 50 350

Concentrator - Log Stream

2,500 4 cores 32 GB 1,800
5,000 4 cores 32 GB 400 2,350
7,500 6 cores 32 GB 500 4,500
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Concentrator - Packet Stream

4 cores 32 GB 1,350
100 4 cores 32 GB 100 1,700
250 4 cores 32 GB 150 2,100

Archiver

2,500 4 cores 32 GB
5,000 4 cores 32 GB 150 250
7,500 6 cores 32 GB 150 350

Scenario Two

The requirements in these tables were calculated under the following conditions.

¢ All the components were integrated.

¢ The Log stream included a Log Decoder, Concentrator, Warehouse Connector, and Archiver.
¢ The Packet Stream included a Network Decoder, Concentrator, and Warehouse Connector.

¢ Event Stream Analysis was aggregating at 90K EPS from three Hybrid Concentrators.

e Respond was receiving alerts from the Reporting Engine and Event Stream Analysis.

¢ The background load Included reports, charts, alerts, investigation, and Respond.

e Alerts were configured.

Log Decoder

o T i i s

10,000 16 cores 50 GB
15,000 20 cores 60 GB 550 100
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Network Decoder

i [ e iors i 7>

8 cores 40 GB
1,000 12 cores 50 GB 200 400
1,500 16 cores 75 GB 200 500

Concentrator - Log Stream

10,000 10 cores 50 GB 1,550 + 50 6,500
15,000 12 cores 60 GB 1,200 + 400 7,600

Concentrator - Packet Stream

CAE Ry

12 cores 50 GB 4,600
1,000 16 cores 50 GB 550 5,500
1,500 24 cores 75 GB 1,050 6,500

Warehouse Connector - Log Stream

EPS | CPU | Memory |Read IOPS | Write IOPS

10,000 8 cores 30 GB 50 50
15,000 10 cores 35 GB 50 50
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Warehouse Connector - Packet Stream

6 cores 32GB
1,000 6 cores 32 GB 50 50
1,500 8 cores 40 GB 50 50

Archiver - Log Stream

10,000 12 cores 40 GB 1,300
15,000 14 cores 45 GB 1,200 900

ESA Correlation service with Context Hub

90,000 32 cores 250 GB

New Health and Wellness
Minimum memory for a standalone virtual host is 16 GB.

Each NetWitness platform host writes 150 MB of Health and Wellness Metrics data into Elasticsearch
data per day. For example, if you have 45 NetWitness Platform hosts then 6.6 GB of metrics data is
written to Elasticsearch per day.

4 cores 16 GB

NetWitness Server and Co-Located Components

The NetWitness Server, Jetty, Broker, Respond, and Reporting Engine are in the same location.

12 cores 64 GB

Analyst Ul

The NetWitness Ul and the Broker, Investigate, Respond, and Reporting Engine services are in the same
location.

Memory | Read IOPS | Write IOPS

8 cores 32 GB 100 350
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Scenario Three

The requirements in these tables were calculated under the following conditions.

e All the components were integrated.

* The Log stream included a Log Decoder and Concentrator.

* The Packet stream included a Network Decoder and the Concentrator.

* Event Stream Analysis was aggregating at 90K EPS from three Hybrid Concentrators.

* Respond was receiving alerts from the Reporting Engine and Event Stream Analysis.

o The background load included hourly and daily reports.

e Charts were configured.

Log Decoder

o | o |t s i 7>

25,000 32 cores 75 GB 1050

Network Decoder

CAECECT Ty

2,000 16 cores 75 GB

Concentrator - Log Stream

EPS | CPU | Memory |Read IOPS | Write IOPS

25,000 16 cores 75 GB 1,200 + 400 9,200

Concentrator - Packet Stream

2,000 24 cores 75 GB 1250 7,050
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Log Collector (Local and Remote)
The Remote Log Collector is a Log Collector service running on a remote host and the Remote Collector

is deployed virtually.

15,000 8 cores 8 GB

30,000 8 cores 15 GB 100 100
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Scenario Four

The requirements in these tables were calculated under the following conditions for Endpoint Log
Hybrid.

e All the components were integrated.

* Endpoint Server is installed.

* The Log stream included a Log Decoder and Concentrator.
Endpoint Log Hybrid

The values provided below are qualified for NetWitness 11.7 for a dedicated Endpoint Log Hybrid with
no other log sources configured.

<= 5K 32 GB Read  Write
core I0PS 10PS
Log Decoder 250 150
Concentrator 150 7,050
MongoDb 250 150
> 5K <= 15K 16 core 64 GB Read  Write
I0PS 10PS

Log Decoder 250 150

Concentrator 150 7,050
MongoDb 250 150

m Memory IOPS Values

> 15K <= 50K 24 core 128 GB Read  Write
IOPS 1I0OPS

Log Decoder 250 150
Concentrator 150 7,050
MongoDb 250 150

If you have more than 20K agents in your virtual deployment, RSA recommends you to do one of the
following:
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e Scale resources such as CPU, RAM, and storage

 Install a physical host (Series 5 Endpoint Log Hybrid)

For details on disk usage, see the Prepare Virtual or Cloud Storage topic in the Storage Guide for RSA
NetWitness® Platform 11.x.

Endpoint Broker
50000 2% 4 GB

Log Collector (Local and Remote)

The Remote Log Collector is a Log Collector service running on a remote host and the Remote Collector
is deployed virtually.

15,000 8 cores 8 GB
30,000 8 cores 15 GB 100 100

Legacy Windows Collectors Sizing Guidelines

Refer to the RSA NetWitness Legacy Windows Collection Update & Installation for sizing guidelines for
the Legacy Windows Collector.

UEBA
16 cores 64 GB 500MB 500MB

Note: RSA recommends that you only deploy UEBA on a virtual host if your log collection volume is
low. If you have a moderate to high log collection volume, RSA recommends that you deploy UEBA
on the physical host described under "RSA NetWitness UEBA Host Hardware Specifications" in the
Physical Host Installation Guide. Contact Customer Support (https://community.rsa.com/docs/DOC-
1294) for advice on choosing which host, virtual or physical, to use for UEBA.
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Appendix D. Update the Virtual ESA Host Memory

ESA current memory is allocated to 65% of the available memory on the host. (For example, with 128
GB available memory, ESA memory will be 81 GB.)

To Update the Memory of the Virtual ESA Host:

1. Power down the virtual machine host and update the virtual host memory from x GB to y GB.
(Example: x = 128 GB and y = 256 GB).

2. Power on the virtual machine host.

Q
3. Log in to NetWitness Platform and go to (Admin) > Hosts.
4. Select the ESA host where the memory is updated and click £ Install @
The Install Services dialog is displayed.

5. Select ESA Primary or ESA Secondary on the host, depending on the ESA host category, and click
Install.

After the installation completes, the memory settings update automatically.

To Check ESA Memory:

On your ESA host, run the following command:

systemctl status rsa-nw-correlation-server
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